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Chapter Awards Banquet: Technical Communication
Yesterday, Today and Tomorrow
Come to the Chapter Awards Banquet to
celebrate the Pittsburgh Chapter’s 45th an-
niversary and STC’s 50th anniversary!
We’ll be honoring this year’s publications
competition winners and Distinguished
Chapter Service Award winners.

Thea Teich, the current first Vice President
and incoming President of STC, will be join-
ing us to talk about the future of technical
communication.  And Chapter Historian
Janis Ramey has assembled a fascinating
collection of chapter artifacts and an online
presentation about the history of the Pitts-
burgh Chapter.  Don’t miss this chance to
commemorate our profession’s past,
present and future!

Bring a Friend!
If your friends or co-workers are thinking
about joining STC but haven’t yet done so,
invite them to the banquet!  We’ll be giving
away a one-year STC membership to a per-
son who isn’t currently a society member.

Door Prizes!
All attendees will have a chance to win
STC memorabilia in our door prize draw-
ing, including STC coffee mugs, magnetic
poetry kits, and other good stuff.  We’ll
also be raffling off a copy of FrameMaker
7.0 (generously donated by Kay Ethier,
who presented at February’s meeting) to
anyone who is interested in using
FrameMaker and doesn’t have a copy.

What is the Future of Technical
Communication?
Most technical communicators are highly
trained, very capable, and deeply commit-
ted people who bring a breadth and depth
of knowledge and skill to any table. Why
then, is so much technical communications
work in danger of becoming a commodity
— a “product” differentiated primarily in
terms of price? How can you turn this per-
ception — and its ramifications — around?
The answer is not simply learning to deal
with the latest technology. Your STC mem-
bership is one important component. What
else is essential for a future in technical
communication? Let’s talk about it on
March 11.

Thea Teich has more than 25 years of
experience in marketing and technical
communications and has held positions
with nonprofit organizations, govern-
ment agencies, and industry.

Since 1995, she has run Teich Technical and
Marketing Communications, offering mar-
keting planning, writing, editing, desktop
publishing, web content production, and
indexing services. She also teaches market-
ing communications in the Informational
Technologies program at Cincinnati State
Community and Technical College.

Thea is currently 1st vice president of STC
and will serve as president starting in June
of 2003. She has also held the positions of
Region 4 Director-sponsor and 2nd vice
president. She is a past president of the
Southwestern Ohio chapter.

Meeting Venue
The meeting will be held on Tuesday,
March 11 at the Engineer’s Society of West-
ern Pennsylvania. For details, please turn
to the last page of this newsletter.
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Chapter Online Competition
Award Winner
Award of Merit

Five Star Development, Inc. and McKesson Automated Healthcare

Title: McKesson AcuScan-RX End User Training

Category: Training

Usability Live!
By David Caruso

On a cold winter morning we made the trek
north.

No this is not the start of a Jack London
tale, but rather how to best start the
story of the joint meeting of three STC
chapters hosted by Youngstown State
University (YSU). The meeting, held
January 18, was a presentation entitled
“Usability Live!” given by Mike Bates,
Manager of the Information Architecture
team at Rockwell Software and STC
Region 4 Director-Sponsor.

Representatives from the three chapters
involved (Pittsburgh, Northeast Ohio, &
YSU student chapter) numbered around
45 and we were a lively bunch. We had to
keep moving as the temperature in the au-
ditorium barely reached 50o C the whole
time we were there. But there was hot cof-
fee and a chance to see everyone in their
winter finery. Who says proper environ-
mental conditions are a pre-requisite for
an effective meeting?

The four activity highlights were:

1. Prepare customer surveys

2. Conduct card sorting activities

3. Design and evaluate low-fidelity
prototypes

4. Conduct live usability tests

Right at the start Bates set the expecta-
tions for the group: we were not there just
to watch a usability test with all the gad-
getry of a mobile usability lab (we would
get to that), nor were we there to learn all
the background of what makes usability a
sought after specialty and a required phase

in major product development. No, we were
there to learn (in four short hours) the ma-
jor usability activities that would occur in a
mock project, namely the redesign of the
YSU technical communications website.

After an overview of the website project,
the attendees divided into groups charged
with developing survey questions for po-
tential users of the site.  Each group then
shared its questions with everyone.  Ex-
ample questions were “How much does the
program cost?” “What classes are offered?”
“What background do the faculty have?”
We then broke for lunch, but not before
getting an assignment: we were to create
index cards containing categories of infor-
mation which answered specific questions
generated from the previous survey. These
cards would be used to develop the organi-
zation of the website.

Lunch, was a very nice “buffet with waiter
service” event and my kudos to the staff
who put on a great (and HOT) meal. We
were all glad not to see lunchmeat (COLD-
cuts) on the menu.  We even got to take
home the leftover food.

In the card-sorting event which followed
lunch, the user (a brave YSU student) was
seated in front of 50+ cards, each with a
piece of information on it. The facilitator
instructed the user to sort the cards into
logical groups. These groups were then
assigned a name by the user, such as “fac-
ulty,” admissions,” financial aid,” etc.  The
sorted cards and category titles were passed
on to the next stage: the low-fidelity proto-
type. Each of the previously formed groups
took one or two of the categorized card
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(continued on page 5)

groupings and developed web page proto-
types.  In the case of our website, the
prototype was paper sketches (no CAD
drawings or Flash modules).

These sketches were what we would use
for the actual usability test. In the test,
another volunteer YSU student user was
brought in and the prototype put before
him. He then used the model to achieve
two tasks; both involved finding infor-
mation by “clicking” on the mock-up and
being directed to the information as it had
been designed using the card-sort exer-
cise. Our student volunteer did very well
and our prototype was successful.

Bates then demonstrated how his mobile
set-up would be used during an actual test.
Cameras, audio recorders and software al-
low for user comments, facial expressions,
and keyboard strokes to be recorded.  The
information could be cataloged on DVD if

there were many tests to complete in one
remote visit.

Hints and tips from the presentation
included:

• Time to Market – a key concept that
defines the company’s deadline to
ship or launch a product…get it “out
the door.” This impacts the place-
ment of usability testing in the
design.

• Watching a user generates much
more usable data than an interview

• Watching = how it really is
• Interview = how the user remem-

bers it

• When asking questions of the user
consider what is most important to
them, not you

• What do they want to know?

Usability Live!
• What action do they want to

take?
While the information presented was vital
to the understanding of usability practices,
the timeframe was way too short. Mr. Bates
said that the day’s presentation was ab-
breviated from an eight-hour presentation
and one audience member from the NEOH
chapter told me that she had seen his pre-
sentation three times and they all felt
rushed since there was so much informa-
tion to cover.

And while I enjoyed the warm reception
by the people in the host chapters, I have
to say that the facility was not ideal given
the thermostat problems.  I also challenge
the leadership of the Pittsburgh Chapter
to host a joint event with the Ohio chap-
ters and engage in an open dialogue with
these folks. There are many ideas we can
share and diverse resources from which
we can all benefit.

FrameMaker7 Demonstration
At the February chapter meeting, Kay
Ethier presented an overview of the latest
release of FrameMaker.  It combines “plain
vanilla” Frame with SGML. You can select
ordinary FrameMaker or the structured
SGML version when you launch it.

Here are some exciting new features:

XML-related features
• Documents have hierarchical

structure and element tagging
consistent with XML.

• You can convert to XML and back
to FM.

• Namespaces are supported

• Cascading style sheets  are
supported.

• Unicode characters can be used.

• FM7 comes with xDocBook,
xHTML, and WebWords Publisher
Standard.

Graphics support
• SVG graphics are supported.

• You can import Adobe Illustrator
files.

• You can import PDFs.

• You can size a graphic by dpi or
percent, and Frame remembers the
original size.

Single-sourcing features
• You can print a book to PDF as a

single file or as separate PDFs from
the dialog box.

• File information is now part of the
document – such as author, title.
This transfers to the PDF.

• PDF is now tagged, that is, it has
structure information, which is
useful for keeping a multicolumn
flow in its proper order.

FrameMaker enhancements
• Acrobat Distiller 5.05 is included.

Save as PDF now works!

• An automated master page lets
you apply a master page based on
a paragraph style. Maximum num-
ber of master pages is 100.

• If you insert a rotated page in a
double-sided document, Frame
adjusts to make sure that your
right/left master pages are correct.

• The Import Format dialog box now
has a Select/Deselect button to
make it easier to select what you
want to import. You now must se-
lect the files in the book that you
want before you import.

• There is a Browse button on the
Print to File field of the Print dia-
log box.

(continued from page 2)
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People News

Society for Technical Communication

Pittsburgh Chapter
P.O. Box 133
Pittsburgh, PA 15230
Contact: Alan Houser
Phone: 412-363-0387
arh@groupwellesley.com

National Office
901 North Stuart Street
Suite 904
Arlington, VA 22203-1822
Phone: 703-522-4114
Fax: 703-522-2075

January MembershipJanuary MembershipJanuary MembershipJanuary MembershipJanuary Membership

Pittsburgh Chapter 192

Total STC 22,222

Welcome new membersWelcome new membersWelcome new membersWelcome new membersWelcome new members

Barbara J. Levine

Tam A. Malloy

Deborah S. Pollio

Notes from the National Office
International Communication SIG is
Looking for Features
Global Talk, the newsletter of the Interna-
tional Communication Special Interest
Group (SIG) of the Society for Technical
Communication (STC), is looking for fea-
ture articles on intercultural communication
for its upcoming issues. Features should
be short (250-500 word) essays, commen-
taries, or articles on issues dealing with

• Culture and communication

• Culture and design practices

• Technology and intercultural
communication

• Translation and localization concepts
and practices

• Interactions involving clients and co-
workers from other cultures

Individuals interested in either submitting
feature articles or proposing/discussing
ideas for feature articles should contact Kirk
St. Amant at stamankr@jmu.edu.

************

Upcoming Telephone Seminars
Wednesday, March 12

Making the Complex Clear and Pretty –
Phylise Banner

Wednesday, March 19

Evaluating an Index (Even if You Only Have
Five Minutes) – Seth Maislin

All telephone seminars are held from 1:00-
2:30 p.m. EST.  Members can register for the
seminars at www.stc.org/seminars.asp.
Cost for a seminar is per site, not per per-
son.  U.S. sites: $145; Canadian sites: $160.

************

50th Annual Conference
The website for STC’s 50th Annual Con-
ference is up and running at www.stc.org/
50thConf/.  In addition to providing com-
prehensive information on educational
and professional opportunities at the

conference, the site features an online
registration form for members.  You can
also view all the technical sessions
scheduled for each day.  Members are
encouraged to visit the site often for the
latest information.  The 50th Annual Con-
ference will be held May 18-21 in Dallas.

************

Deduct Your STC Dues
If you pay taxes in the U.S., you can deduct
your STC dues in one of several ways:

Charitable Expense
If you claim your dues as a charitable do-
nation, you can deduct the dues amount
minus the portion that goes for tangible
benefits.  For the STC, the tangible value
of your dues is $30 ($15 for Intercom and
$15 for Technical Communication).

Business Expense
Employees and self-employed consultants
may claim the full amount of dues as a busi-
ness expense.

Miscellaneous Expense
Those who do not fall in the categories
about can claim their dues as a miscella-
neous expense.

Check your tax information booklet or con-
sult with a tax representative for exceptions,
limitations, and other regulations.

************

Don’t Lose Touch with STC
The Society Office encourages all STC
members to update their membership infor-
mation with home addresses, home phone
numbers, or home email addresses.  Many
members provide only their work contact
information, and the office often loses track
of these members when they change jobs.
To update your membership information,
complete the STC address change form at
www.stc.org/address_change.asp or con-
tact the office at 703-522-4114.
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• There are 12 Running H/F vari-
ables.  You can customize headers
and footers to your heart’s con-
tent.

• UNIX font management is
iincluded.

• Save as MIF (Maker Interchange
Format, a format that any version
of Frame can open), FM6 PDF,
Word, Word Perfect, HTML,
XML, SGML

• Tables now come across.

Special Structured FrameMaker
features

• In a numbered list, if you move
Number1, Frame renumbers for
you!  No need to adjust the para-
graph styles.

• Formats are in the template EDD.
No need to import formats when
you update or correct.

Help through the Help button
• On-line

• User’s manual

FrameMaker7 Demonstration

• XML Cookbook

• FM7 Reviewer’s guide

• Overview of new features

• Workgroup guide, a feature used
for document control

• Tutorials

• Structured templates

You also can order from www.adobe.com a
CD copy of the Guide to Enterprise Pub-
lishing, which describes how various in-
dustries use FrameMaker.

(continued from page 3)

STC Chapter Meeting Schedule
Mark your calendars!  Here are topics and
tentative dates for the remainder of the
2002-2003 meeting calendar.  More details
on each meeting will be published as the
dates draw closer.

2003:
March 11 (Tuesday) — Chapter 50th Anni-
versary Party and Awards Banquet (Thea
Teich and Janis Ramey)

April 8 (Tuesday) — Robohelp (Leslie
Johnson)

May — Spring Fling Party (date to be de-
termined)
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Access Database Primer, Part 2
by Robert P. Mohr

In last month’s article, I discussed how to create tables, forms,
and combo boxes. In this article, I’ll discuss how to embellish
your forms using form properties and input masks, and also how
to use the report wizard to create simple reports.

1. Begin by opening the database you created last month. All
of the form enhancements made in this article will pertain to
the main input form.

2. Click Forms in the Objects list to display all available forms.

3. Right-click on the Personal Knowledge Base form and se-
lect Design View from the shortcut menu. The Form De-
signer is displayed, as shown in Figure 1.

1. Double-click the black square to view the form’s properties.

The Form’s properties box enables you to alter the appearance
and function of the form:

Each property tab has a role to play:

••••• Format – contains properties to control the form’s ap-
pearance.

••••• Data – contains properties related to the source of data
displayed by the form, filtering information, and op-
tions pertaining to data entry.

••••• Event – contains functions that the form can perform
based on one or more events, such as when the form
opens or closes.

••••• Other – contains properties for related help files,
toolbars, menus, and the form’s modality.

••••• All – all properties from all tabs are displayed in a single
list.

Changing any of the properties is simply a matter of clicking on
them and selecting from the list of available options. For this
form, the changes are few.

1. Change the following Format properties:

Format property Change to

Allow Datasheet View No

Allow PivotTable View No

Allow PivotChart View No

Scroll Bars Neither

Record Selectors No

1. Click the X in the upper-right corner of the box to save and
exit the properties.

Now change the background color of the Detail section of the
form:

1. Right-click anywhere in the Detail section of the form and
select Properties from the shortcut menu. Another proper-
ties box is displayed.

2. Change the Back Color property under the Format tab:

a) Click the Back Color property’s button. A color palette
is displayed.

b) Choose a new color from the palette.

c) Click OK.

d) Click the X in the upper-right corner of the property
box. The form’s background color changes.

Try changing the background color of the form’s Header section
using similar steps.

The last change to make to the form is to add an input mask to the
Date field. Input masks make good visual references to clue us-
ers in on how data should be entered. Input masks can also save
time and improve consistency in data entry because they can
provide certain default characters.

(continued on page 7)
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1. Right-click on the input box portion of the Data field and
select Properties from the shortcut menu.

2. Click in the Input Mask property under the Data tab.

3. Click the Input Mask’s property button to launch the Input
Mask wizard.

1. Select the Short Date option. To see what the mask will look
like, click in the Try It box.

2. Click Next > to continue. Here, you can alter the place-
holder character if you wish. The underscore is the default
character.

3. Click Next > to continue.

4. Click Finish to complete the Input Mask. The Input Mask is
displayed in the Input Mask property box.

5. Click in the Default Value property box and type: Date().
This causes the current date to automatically fill in. You can
override this date by entering another date.

6. Click the X in the upper-right corner to close the properties
box.

Finally, set the tab order so you can “Tab” from field to field:

1. Click anywhere in the Detail section’s background.

2. Select View > Tab Order.

3. Click and drag the fields in the Custom Order list to rear-
range them or click the AutoOrder button. For this simple
form, AutoOrder works fine.

4. Click OK.

5. Save and close the form.

Open the form and examine the changes. Try entering a few
records. (You’ll need some data to view in the report anyway.)

Using the Report Wizard
The easiest way to create reports is with a wizard. Access offers
several wizards for a variety of reports. You can create labels,
charts, and standard reports. The following example creates a
report of all records in the database organized by topic and by
date. Once the report is created, you can tweak it as much as you
want.

1. Click Reports in the Objects list.

2. Click the New icon. The New Report box is displayed.

3. Select Report Wizard from the list, choose the Text table
from the drop-down list, and click OK. The Report Wizard is
launched.

4. Select the Date, Topic, Source, and Text fields and click the
> button to move them to the report.

5. Click Next > to continue.

6. Select the Topic field and click the > button to create a group.

7. Click Next > to continue.

8. Select Date from the 1. drop-down menu and click the As-
cending button to toggle it to Descending.

9. Click Next > to continue.

10. Accept Stepped as the default layout by clicking Next > to
continue.

11. Select Corporate for the style.

12. Click Next > to continue.

13. Type a name for the report, such as Knowledge Base Con-
tents.

14. Select the Modify the report’s design radio button. This
places the report in the Report Designer where you can
modify it if necessary.

Access Database Primer, Part 2
(continued from page 6)

(continued on page 9)
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WorkQuestΤΜΤΜΤΜΤΜΤΜ     Meeting Summary
The Pittsburgh Chapter’s WorkQuest
group continued its weekly meetings in
January.

January 7: New Year: New Approaches to
Job Searching
At the first meeting of the year, members
described the changes they planned to
make to their job search techniques. The
plans reflect the variety of people at the
meeting and the variety of techniques they
employ.

Some people felt they have been spending
too much time at meetings and not enough
in making phone calls and sending out
résumés. They plan to cut back on meet-
ings. Others felt just the opposite – that
they had not been spending enough time
networking and plan to do much more. They
thought they would start attending net-
working groups such as PAPEN or Geek
Night or attending other technical society
meetings.

At least one person plans to shift his en-
ergy away from the survival job he’ s been
doing to focus more on his search for a
technical writing job. Another person has
decided to shift his focus from looking for
permanent full time work to collecting
enough contracts to keep him busy full time.

Several people plan to completely redo their
résumés and to create additional sample
cover letters so they have something eas-
ily and quickly adaptable to any job situa-
tion that comes along. One or two people
plan to create a job search website.  Almost
everyone wants to become more organized
and to keep better records of contacts,
phone calls, résumés sent, and responses.

January 14: Human Resource Issues –
John Gilmore
John returned for his second appearance
as a guest speaker. John is a freelance
human resource counselor who also vol-
unteers at the Carnegie Library Job and
Career Education Center. This meeting
focused on how to network to make con-
tacts that will lead to a job.

John and STC WorkQuestTM member Jim
McCarty did some roleplaying of good and
bad ways to try to network with someone.
John suggested for people who don’t want
to make networking cold calls, find a friend
of a friend who may be in a position to help
you find a job and is willing to talk to you.
Try to talk to as many people as possible,
and don’t let refusals bother you. John then
gave some tips about what to do when you
make a networking contact.

• If you can get someone to have a net-
working meeting with you, ask if you
can send them a résumé so that they
are familiar with you before the meet-
ing, but never force your résumé on a
contact. The purpose is not to ask the
contact for a job at the first meeting,
but to familiarize them with your back-
ground and see if they can give you
any information that can help you in
your job search.

• When you answer a job advertisement,
try to call and talk with the company’s
HR department even if it says not to
call in the advertisement. Don’t ask
about a specific job, but about the com-
pany in general. When you call a com-
pany, try to identify the HR person who
is handling the job you are interested
in, or even the person who is the hiring
manager for the position.

• When you make a networking contact,
always offer to return a favor if you’re
asking for one.

John suggested talking with people at the
Pittsburgh Technology Council. Many of
them are willing to help people who are look-
ing for technical jobs.

January 21: Marketing Materials
On this very cold day, a small but dedicated
group showed up for the meeting, includ-
ing one new member. As a followup to our
December 17th meeting, the group discussed
marketing materials that you can use to sell
yourself. We discussed all of the marketing
pieces that the members brought. Jay

Keefer brought some exceptional brochures
that he and his wife Chris made up for their
businesses. They bought their brochure
paper from a catalog/online company called
Paper Direct. Most of the members brought
their résumés, and the group members
commented on good points, and made
suggestions on possible improvements.
One member brought a flyer that contained
a description of all of the services that they
could provide for a client.

January 28 & February 4: Setting up a
Job Search Website
Originally, only the January 28th meeting was
scheduled to discuss setting up a personal
job search website. There was so much in-
terest in the presentation of WorkQuest
member Joyce Hall and her husband Jim
Gogots that it was extended to the  Febru-
ary 4th meeting. The two meetings were very
well attended.

(continued on page 12)
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Access Database Primer, Part 2
(continued from page 7)

15. Click Finish to create the report. You should see something
similar to Figure 4:

Click the Print Preview icon at any time to see how the report
looks. Click the Close icon to return to the Report Designer win-
dow.

You can modify just about everything about the report. Like
forms, reports also have properties which are accessed by
clicking the black square in the upper-left corner (see Figure
4). You can also rearrange and resize the fields. Left click on a
field to select it. Once selected, you can drag it, change its
font, justification, etc. Right-click on a field to access and
change its properties. Figure 5 shows the report after I relo-
cated a few fields and resized the Text field to show two lines
of the field’s text in the report.

Your report should look something like this:

When you’re satisfied with the report’s appearance, save and
close it.

Next month’s article will introduce queries and how to use que-
ries as the source for reports. You can go to www.writemohr.com
(Free Stuff section) and download a copy of the database with
the enhancements explained in this article.

Bob Mohr is a senior STC member and author of The Elements of
Word. He can be reached via e-mail at rpmohr@writemohr.com.

TechComm

Experienced Technical Writer
Experienced Researcher

• Research Proposals

• Grant Proposals

• Contract Proposals

• Research Reports

• Articles

• Monographs

• Training Materials

Telephone: 412-343-2508
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The following individual submitted a statement on her candidacy for STC second vice president. This statement is included here for your
information. Inclusion of this statement in the Blue Pencil does not imply endorsement of the candidate by the officers of the Pittsburgh
Chapter STC or of the Blue Pencil staff.

Statement of Sandi Harner, Candidate for Second
Vice President

The position of second vice president of
STC is a very important one because the
person elected will automatically become
first vice president and then president. I
would appreciate your vote for second vice
president of STC.

My experience with STC began in 1984
when I became a member. In 1985, I de-
veloped the technical and professional
communication major for Cedarville
University where I have now taught for
more than 20 years. In 1988, I chartered
the Cedarville University Student chap-
ter, and have advised it since then. The
value that I’ve received from my STC
membership is immeasurable. Through
chapter meetings, publications, and
conferences—both regional and an-
nual—I have learned so much while
developing a professional network as
well as a network of friends.

I began my involvement on the international
level in 1992 as manager of Sigma Tau Chi.
That quickly led to manager of the Jay R.
Gould Award, judging for the Ken Caird Stu-

dent Article Competition, reviewer of pro-
posals for the STC Annual Conference, and
onsite judge for the International Technical
Publications Competition. I am currently
serving on the STC Board in my fourth year
as Assistant to the President for Academic
and Research Programs. In that capacity, I
am responsible for eight committees.

I was named Fellow in 2001, received the
Jay R. Gould Award for Excellence in Teach-
ing Technical Communication, and named
Associate Fellow in 1996.

As full Professor at Cedarville University, I
have directed the technical and professional
communication program since its beginning.
My responsibilities, in addition to teaching
a full course load, include developing cur-
riculum, securing and supervising fulltime
and adjunct faculty, advising students, su-
pervising independent studies, placing and
supervising student internships, and ad-
vising the STC student chapter.

In addition, I have served as an indepen-
dent consultant, contract writer, and
trainer since 1976. In 1997, I received the
STC Faculty Internship Grant and worked
as a Communications Manager in a tech-
nical marketing communication firm. In
2002, I co-authored Technical Marketing
Communication, part of the Technical
Communication Series published by Allyn
& Bacon/Longman.

For almost twenty years, my passion has
been to prepare young people to make a
significant contribution to the profession
of technical communication. That role has
kept me focused on core competencies,
emerging technologies, and communities of
practice. My current position on the STC
board for the past four years has provided
many opportunities to work at the Society
level with initiatives such as research grants
and special opportunities grants, as well as
chapter-level activities in helping to develop

mentoring guidelines and education com-
mittees.

In the last few years, the growth of com-
munities of practice has broadened our
traditional definition of technical commu-
nication. This is evidenced by the sig-
nificant growth in the STC SIGs, which
now number more than 20 with a total
membership of 26,441.

If we are to be effective as the leading
professional organization for technical
communication, we must actively em-
brace those non-traditional groups such
as Web designers, technical marketing
communicators, usability experts, in-
structional designers, and others who
make up the workforce of today’s tech-
nical communicators. The challenge is
to help the employers and employees
alike to perceive them as the technical
communicators they are.

I believe that all these experiences prepare
me to fulfill the responsibilities of the sec-
ond vice president of STC, as well as first
vice president, and finally the president. The
Academic Vice President, my Dean and
Department Chair have pledged their full
support should I be elected second vice
president. This support will be evidenced
by a decreased teaching load as well as fi-
nancial support for the travel involved in
the position.

When it is time to vote in the STC election,
please take the time to go online or mark
your ballot and vote for Sandi Harner—STC
Second Vice President.

For more information, please see
www.sandiharner.com
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The following individual submitted a statement on her candidacy for STC second vice president. This statement is included here for your
information. Inclusion of this statement in the Blue Pencil does not imply endorsement of the candidate by the officers of the Pittsburgh
Chapter STC or of the Blue Pencil staff.

Statement of Suzanna Laurent, Candidate for
Second Vice President

While visiting Detroit’s Henry Ford Mu-
seum, I learned about Ford and the auto-
mobile he made so successful. Many people
have the mistaken idea that Henry Ford was
an inventor, but Ford did not invent the
automobile. He didn’t even “invent” the
assembly line.

So what did Henry Ford do? He learned
from other people’s experiences as well as
his own. He took risks. He saw failure as a
lesson, and he applied everything he
learned to improve the product, the pro-
cess, and the policies that shaped the
American automobile industry. In short, he
was a great innovator. And because he was
so willing to share the lessons he learned,
he became an inspiration to many others.

I am running for second vice president be-
cause in my own way, I want to do as Henry
Ford did. He wanted to “learn from other
people’s experiences as well as his own.” I
want to use the lessons that I have learned
in 25 years of management and leadership
positions to create solutions that will en-
sure STC becomes an organization that is
vital to the diverse careers of technical
communicators.

One innovative thing I did as a director-
sponsor (1999-2002) was to attend con-
ferences and give chapter programs in
every region to meet our members and
listen to their ideas. As a result, I have
presented 103 conference sessions, lead-
ership workshops, and chapter programs
in locations from Toronto to Hawaii. In
addition, I have written 30 articles that
have been published over 500 times in
STC newsletters. This “listening tour”
instilled a greater understanding of the
unique challenges facing us, some of
which are addressed in my articles.

While serving as director-sponsor, I gained
a thorough understanding of the issues and
concerns about STC at many levels. Work-
ing individually with leaders and other
members is an invaluable experience that is
crucial to being the most effective leader in
the “presidential chain of offices.”

Ford also “took risks.” Failing to be inno-
vative and leaving things at the “status
quo” is a risky business for STC and tech-
nical communicators. We must make it part
of our role as technical communicators to
show the value we add. We must continue
to learn more, do more, and be more. It is
important that STC become the “premier”
organization for technical communicators.
One way we can do that is by listening to
what our members want, because the orga-
nization that best meets the needs of its
members is the one that retains its members
and attracts new ones.

Ford “saw failure as a lesson, and applied
everything he learned to improve….” Dur-
ing the process of defining STC’s brand,
we discovered where we were making our
mistakes and that we were not being per-
ceived as we wanted to be, so we’ve made
changes to correct some of those miscon-
ceptions.

As we seek new ways to prosper, we must
improve our processes and the quality of
our member services.

STC members work in more diversified
environments than ever before, with ex-
perience, skills, and talents that vary
widely. Nevertheless, we share the desire
to be recognized for our contributions
to the workplace. By more proactively
promoting our field, I believe that STC
can make a difference in the careers of
our members.

There are other important strategies to con-
sider as we seek to progress. To learn more
about my experience and what I have con-
tributed pertaining to these strategies, read
the expanded version of this article at http:/
/pages.prodigy.net/slaurent or contact me
at slaurent@prodigy.net.

With experienced leadership and guidance,
STC can become the catalyst that enables
technical communicators to achieve the
professional status they have earned. When
that is accomplished, we will have fulfilled
my vision for STC to become an organiza-
tion to which technical communicators feel
membership is essential to their careers.

I would sincerely appreciate your vote
for me as the next second vice president,
because I firmly believe that when a col-
lection of minds, hearts, and talents work
together, great things can happen!
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Editorial Calendar
Please send your submissions to Meg Papa at mv0t@andrew.cmu.edu.

Article Deadline
The deadline for the next issue of the Blue
Pencil is Monday, March 3.  Please send
your submissions to Meg Papa at
mv0t@andrew.cmu.edu.

Meeting Details: March Awards Banquet

A personal job search website is used to
present your skills and talents to potential
employers. It is similar to a website that
advertises a business, but unlike a busi-
ness website, it would be dismantled once
you find employment. You can create your
website in an HTML editor like FrontPage,
or even use Word and write your pages out
as HTML. Some of the points discussed by
Joyce and Jim included:

• Consider cost – development time,
money and maintenance involved in
setting up the site

• Define your sales message – know your
target audience, address their ques-

WorkQuestTM Meeting Summary
(continued from page 8)

tions about your skills, offer them a
benefit, set yourself apart

• Brand your web site – have a consis-
tent look to it that can be identified as
yours, have a motto for yourself

• Include your contact information

• Use good design techniques – color
and style should project your business
image; use a simple, clean look; use
small graphics that download quickly

• Test your page before publishing it on
the web

Several of the WorkQuest members ex-
hibited their own personal job search
websites and made some suggestions for
items that should be included. Some of

these suggestions included: testimonials
from clients, case studies, either a résumé
or a short biography and a list of experi-
ence areas, pictures of items you’ve had
published, lists of awards you’ve won, and
types of projects you’ve worked on. There
was some discussion of whether to list spe-
cific clients because some of them might
not want to be listed, and the list could pos-
sibly be used by your competitors as a
source of possible clients.

WorkQuest was formed as a resource for
you. Many interesting topics are planned
for the next month. Notices of the meetings
can be found on the WorkQuest web site
http://home.earth l ink.net/
~workquest/.

Date: Tuesday, March 11, 2003

Location:    The Engineer’s Society of
Western Pennsylvania, 337 Fourth Av-
enue, Downtown Pittsburgh.  Maps and
directions are available at http://
www.eswp.com. There are parking lots and
garages in close proximity to the Engineer’s
Society building.

Schedule:

Networking (cash bar):  5:15 - 6 PM

Dinner:  6 - 7 PM

Presentation:  7 - 8 PM

Menu Selections:

Select one:

Chicken Riviera – Boneless breast
topped with sliced tomatoes,
garlic butter and Asiago cheese

Tenderloin of Beef Alexandria –
Lightly breaded with a sauce of
lemon, shallots and mushrooms

Stuffed Shells

Cost: $22.00

$12.00 students and unemployed

RSVP:    To Darlene Mullenix at
dmullenix@federatedinv.com or 412-288-
8676 (W) by March 7, 2003. Include your
entrée selection and a daytime phone num-
ber.

The banquet cost must be paid in full be-
fore the banquet! All checks must be re-
ceived by March 7, 2003.
Make your check payable to “STC–Pitts-
burgh” and mail it to:

STC–Pittsburgh

P.O. Box 133

Pittsburgh, PA, 15230

IMPORTANT! Cancellations received after March 7, 2003 will be charged full price.
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